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Introduction
What's in this Manual
This manual provides a menu-by-menu, screen-by-screen listing of
controls and settings available with FlexColor. Topics include:

• Summaries of all menu commands
• Descriptions of all controls and settings in the main FlexColor
window

•
•
•
•
•
•

Information about rotating and mirroring images
Full details of all tab sheets in the Setup window
Full details of the Preferences window
Instructions for editing ColorSyncTM profiles
Brightness and contrast control with the Gradations window
Advanced highlight and shadow settings with the Histogram
window, including color neutralization and control

• Advanced color control with the Color Correction window
• Sharpening images with the Unsharp Masking window
• Batch scanning to create individual scans from each of several crop
and settings combinations

Software compatibility
The FlexColor 3.0 software works with the entire range of Flextight
scanners (except for the Flextight 4800).

FlexColor under Mac OS and Windows
The CD that came with your scanner includes versions of FlexColor for
both Macintosh and Windows-based systems.
The interface is nearly identical on both platforms, with mostly
superficial differences to conform with the interface guidelines of the two
systems.
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Introduction
System Requirements

Nearly all of the screen captures in this manual were taken from Mac OS.
Windows users will notice the following differences:

• In the Setup window, the color management tab is called ICM instead
of ColorSyncTM.

• The menus are located at the top of the main FlexColor window
instead of at the top of the screen.

• The Windows version uses standard Windows frames, with standard
maximize, minimize, and close buttons.

System Requirements
IBM PC-Compatibles
• Minimum 233 MHz processor.
• Windows 95/98, NT4, 2000 and ME.
• Windows 98, 2000 or ME is required for scanning to CMYK and color
management (ICC profile) support.

•
•
•
•

Minimum 64 MB system RAM.
Screen resolution of 800 x 600 pixels with true colors (24 bits).
Mouse or other pointing device.
FireWire interface
or
SCSI Interface (with Adaptec EZ-SCSI version 4 or later).

• Minimum available hard disk space of 200 MB

Macintosh
•
•
•
•
•

Minimum Power PC processor.
Mac OS 9.0 or higher.
Minimum 64 MB system RAM.
Screen resolution of 800 x 600 pixels with true colors (24 bits).
FireWire interface
or
SCSI interface.

• Minimum available hard disk space of 200 MB.
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Memory Configuration
The required memory allocated to the program will vary depending on,
whether you are working with a scanner or a camera. When launching
FlexColor for the first time a Memory configuration window will pop
up giving you a choice of 3 memory configurations:

Small (=50 MB)

Only scanners are supported.

Medium (=100 MB) Only scanners - but with improved rotation speed.
This setting is also recommended when scanning
high resolution scans on a slow host computer.
Large (=192 MB)

Supports both scanners and cameras.

The configuration will not be effective before quitting and relaunching
the application. If you need to change the configuration you can access
the dialog by pressing the Memory Usage button in the Preferences
window.
The memory configuration affects the settings that are accessible via the
Finder Get Info window, and you are free to fine tune the settings there
if you need to.
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FlexColor Menus
FlexColor commands are available via a standard menu bar. Each of
them is described briefly below. Note that most menu entries also list a
keyboard shortcut to the right of the entry. Try to remember and use
these shortcuts to speed your work.

The File Menu
The File menu includes entries that initiate scans and make settings for
FlexColor.

• Scan Preview: Takes a low-resolution, 14-bit-per-color preview scan.
This image will be displayed in the main FlexColor window so that
you can preview settings and crop the image for the final scan. All
settings are previewed using the full 14-bit color depth to display
results.

• Final Scan: Takes a final-resolution scan and saves it on your hard

disk. All of the settings you made after taking the preview scan will be
combined with the standard settings for your selected setup and
applied to the final image.

• Setup: Opens the Setup window, in which most of the basic settings

for a scan can be made, saved and loaded. See "The Setup Window" on
page 25 for more information.

• Preferences: Opens the Preferences window, which enables you to
select an application for viewing final scans, make power-saving
settings, and set up custom original holder formats. See "The
Preferences Window" on page 41 for more information.
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The File Menu

• Quit: Quits FlexColor.
• Devices: Opens the Devices window.

Here you can select which camera or scanner device you want to work
with, as it lists all connected devices - click on the one you prefer and
click the Select button. If you have only a single scanner or camera
connected this device is automatically chosen.

The disabled functions in the menu (Close, Page Setup and Print) are not
accessible when working with Flextight devices.
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The Edit Menu
The Edit menu contains entries that enable you to undo multiple actions
that you have made while making settings in FlexColor. It also enables
you to cut, copy and paste text in various windows.

• Undo: Reverses your most-recent actions for example, a crop area

modification or a change in the Setup window. You are able to step
back through a long series of actions.

• Redo: Reapplies the last action that you cancelled using the Undo
command.

• Cut: If you have selected some text in a text field, then this command
removes the text and saves it on a system-wide virtual clipboard.

•
•
•
•

Copy: Saves the selected text on the clipboard without removing it.
Paste: Places a copy of the text on the clipboard at the insertion point.
Clear: Removes all text from the clipboard.
Select All: Selects all of the text contained in the field in which the
insertion point is standing. In the Batch Scan window, this selects all
of the listed scans (see "Batch Scanning" on page 69).

• Show Clipboard: displays the current contents of the clipboard.
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The Maintenance Menu
The Maintenance menu includes entries that are used for calibrating and
cleaning the scanner. The functions of these entries will depend on the
model of Flextight scanner you are using. See your scanners hardware
documentation for details of when and how to use these commands.

• Focus Calibration: Opens the Calibration window, which calibrates
the focus and sizing of the scanner. Only Flextight Precision and
Flextight Progression require this function.

• White Calibration: Initiates a white calibration scan for reflective

originals. Only scanners that support reflective scanning require this
function.

• Cleaning: Prepares the scanner so that you can clean the internal

white calibration surface. This is only possible with some older
Flextight Precision scanners. However, we now recommend using the
external white calibration method even with these scanners, in which
case cleaning is never necessary.

• CCD calibration: Calibrates the CCD to make sure all pixels react the
same way to equal levels of light. See "CCD Calibration" on page 75
for more information about this feature.

• OptiRes upgrade: Starts the OptiRes upgrade function.

The OptiRes function (See "OptiRes Functionality" on page 22 for
more information) is a standard feature for all Flextight Precision III
and Flextight 8000 scanners. If you have a Precision II scanner you will
have to upgrade it as described in "OptiRes Upgrade" on page 22.
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The Windows Menu

The Windows menu opens and closes each of the image settings window
available with FlexColor. Each window that is currently open shows a
check mark to the left of its name. For more information about each of
these windows, see the appropriate section later in this manual:
Gradations window - see page 51.
Histogram window - see page 57.
Color Correction window - see page 63.
Unsharp Mask window - see page 65.
Magnifier window - see page 67.
Batch Scan window - see page 69.
Color Info window - see page 73.
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The Main FlexColor Window
Introduction
The main FlexColor window displays your preview images and
provides access to most of the scanning and image editing functions
available with FlexColor.

Scan Controls
Preview

Click this button to take a preview. A preview image will
appear in the large area on the right. All image correction
settings (such as tonal range, gradation and color
corrections) will also be previewed on this image.
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The Main FlexColor Window
Size Controls

Scan

Click this button to take a final scan using the current image
correction, size, and color separation settings.
Batch Button: Click this button to initiate a batch scan, in
which each of several crops will be saved as different files
using different settings. See "Batch Scanning" on page XX for
more information.

Setup

Use this pop-up menu to choose between any of the
currently available setups. A small + will appear to the right
of the menu to indicate when you have made custom
changes that affect the setup but have not been saved.

Frame

Use this pop-up menu to set the film format (size) of the
original you are scanning.

Mode

Use this pop-up menu to set the scan mode (RGB, RGB 16
bit, Grayscale, Grayscale 16 bit, Lineart, or CMYK). This
setting mirrors the Mode setting on the General tab of the
Setup window. See "The General Tab" on page 28 for more
information.

Optimize

In the Optimize pop-up you have the following options:
Quality: Use this setting to obtain the highest quality.
Speed: Enables faster scan times by taking greater advantage
of resizing.
True Resolution: Use this mode to avoid any kind of
software resizing.

Size Controls
Width

The measured width of the output image. The units used are
set on the General tab of the Setup window. See "The
General Tab" on page 28 for more information.

Height

The measured height of the output image. The units used are
set on the General tab of the Setup window. See "The
General Tab" on page 28 for more information.

Zoom

The level of magnification applied during scanning.
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DPI

The output resolution of the final scan. Note that those
settings that, combined with the current Zoom setting, will
result in a non-interpolated (true optical resolution) scan are
shown underlined. See your scanners hardware
documentation for more information.

Size

The file size of the final scan. This is affected by the Width,
Height, and DPI settings.
Lock Button: The lock button enables you to lock the output
width and height settings. When the lock is closed, then the
output width and height will not change when you modify
the crop area or zoom value, and the proportion of height to
width will be maintained. If you edit the Height or Width
values while the lock is closed, the crop area will stay the
same, but the Zoom value will change. Click on the lock to
toggle its setting.
Crop Button: Usually this button is gray, which indicates
that the crop tool is active. When the crop tool is active, you
are able to click and drag on the preview image to create and
manipulate the crop area. However, some tools, such as the
color pickers, change the cursor so that it selects colors
instead of defining a crop area. When one of these tools is
active, the crop button is white. To return to the crop tool,
click on the crop button.

Note the following points about working with the crop and size tools:

• When you work with the scanner, you will typically know the target

output dimensions and resolution. If so, first enter the dimensions in
the Height and Width fields and choose the output resolution from
the DPI pop-up menu. Then click on the Lock icon so that it is closed
(this will lock your height and width settings). You are now able to
click and drag the crop area to define the composition of your scan.
The Zoom value automatically tracks your changes without changing
the height, width, or DPI of your output image.

• To set the crop area, place the mouse cursor over the preview image.

Click and hold over one corner of the area you wish to scan and drag
the cursor away to outline the scan area. Release the mouse button to
select the area.

• To move the crop area, place the mouse cursor inside the outline, then
click and drag the area. Release the button to drop the area again.

• To resize the crop area, place the mouse cursor over one of the sides or
corners. The cursor will change into a double sided arrow. Click and
drag the side or corner to stretch or shrink the area.
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The Main FlexColor Window
Zoom Controls

Zoom Controls
Zoom Out: Click this button to make the preview image
smaller.
Zoom In: Click this button to make the preview image
larger.
Normal Zoom: Click this button to resize the preview to fit
the window.
Magnifier: Click this button to open the Magnifier window.
This window shows a strongly magnified view of the preview image that tracks the motion of your cursor. See "The
Magnifier Window" on page 67 for more information.

Keyboard shortcuts for zooming
• To fit the entire preview image in the window, type cmd-0.
• To zoom to 100%, type alt-cmd-0.

Color Display

To use the Color Display, place the mouse cursor over the preview
image. The number fields in this area indicate the pixel brightness at the
selected position in the image.
Note the following:

• The values indicate values after gradation and tonal range settings.
• When showing CMYK, the values indicate ink percentage values (0 100) with white = 0, 0, 0, 0.

• When showing RGB, the values indicate pixel brightness values (0 255) with white = 255, 255, 255.

Color Info button: Opens/closes the Color Info window.
This window is also available from the Windows menu. See
detailed description in "The Color Info Window" on page 73.
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Corrections Controls
Auto

Click this button to apply automatic settings for highlight
and shadow points based on the histogram of your image.

Reset

Click on this button to return all correction windows
(Gradations, Histogram, Color Correction, and Unsharp
Mask) to their neutral settings.
Gradation Button: Opens/closes the Gradations window.
See "The Gradations Window" on page 51 for more
information.
Histogram Button: Opens/closes the Histogram window.
See "The Histogram Window" on page 57 for more
information.
Color Correction Button: Opens/closes the Color
Correction window. See "Selective Color Correction" on
page 63 for more information.
Unsharp Mask Button: Opens/closes the Unsharp Mask
window. See "Unsharp Masking" on page 65 for more
information.

Other Controls
Mirror Button: Mirrors the preview and final image.
Rotate Buttons: Rotates both the preview and final image
90° either clockwise or counter-clockwise. See "Rotating
Images" on page 21 for more information.

Orientation Icon: Shows the current rotation/mirroring in
relation to your scanned original.
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The Main FlexColor Window
The Preview

Softproof Mark the checkbox to activate the Softproof feature. This
feature combines the ICC color profile of your monitor with
the profiles of your scanner and output device to provide a
simulation of the output colors on your screen. Click on the
box to toggle the check. The result shown is only an
approximation - you may find it most useful to work with
this option turned off.
Grab tool: Holding down space activates the grab tool
allowing you to drag the contents of the preview window
around.
Grid button: Makes a grid over the preview. The grid can be
useful for aligning your original before the final scan.
Holding down the option key while clicking the Grid button
opens the Grid options window:

Define the number and color of the lines in the grid.
The number of lines is per the smallest image dimension
(width or height).

The Preview
FlexColor has been designed with the philosophy that when creating
digital images, it is best to judge image quality with your eyes, not based
on point measurements and color lookup tables. This is why we have
drawn so much attention to the screen calibration procedure in the
tutorial, and why we have integrated ICC color profiles to maintain the
color accuracy you see on your screen all the way to print.
To make it easy for you to see and use the preview, FlexColor provides a
large 14-bit image with a zoom function and magnifier window. Because
your monitor can only show 8-bit colors, FlexColor calculates a new 8-bit
image from the 14-bit information each time you apply a highlight,
shadow, gradation, or color setting. This creates a very accurate preview
image.
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Rotating Images
In some cases, your originals may be rotated so that they
appear sideways in relation to the FlexColor preview
window. If this annoys you, you can use the rotate buttons to
rotate the image 90° either clockwise or counter clockwise.
Both the preview and the final image will be rotated.
Note that scanning rotated images will require more memory and will
slow down your scans slightly - especially for large scans.
To improve the performance of the rotation function under Mac OS,
increase FlexColor's memory partition by using the procedure described
below.
NOTE! This operation is not necessary if you are using Windows or if
you have already set the Memory Configuration to Medium (=100 MB)
when starting up FlexColor for the first time. See "Memory
Configuration" on page 7 for details.
Increase memory partition as follows:
1.

Quit FlexColor if it is running.

2.

Find the FlexColor application icon on your hard disk and click once
to select it.

3.

Select Get Info from the File menu and select Memory in the Show
pop-up.
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The OptiRes Functionality

4.

Edit the value shown in the Preferred Size field at the bottom of the
window. If you have enough memory, then increasing the value to
up to at least 100 MB (100000 K) will speed your rotated scans.

The OptiRes Functionality
The OptiRes functionality has the following advantages:

• The resolutions of the standard frames are fitted more accurately to

the actual holders, leading to higher resolutions in frames like 36x24
and 24x36, which will be scanned in 5000 dpi and 6300 dpi
respectively. This also results in speed increases when scanning lower
resolutions.

• You are able to specify the exact width of your custom frames. Note

that the width automatically determines the max. optical resolution.

• You are able to work in a True Resolutions mode, where scans are

never software resized - the scanner will always focus exactly at the
chosen input resolution (output dpi * Zoom percentage).

NOTE! Reflective scans are still limited to a few fixed resolutions
because of the fixed white calibration used in reflective mode.
To work in True Resolutions mode select True Resolutions in the
Optimize pop-up in the main FlexColor window (see page 16).
NOTE! The OptiRes function is a standard feature for all Flextight
Precision III and Flextight 8000 scanners.
If you have a Precision II scanner you will have to upgrade it as
described in the following.

OptiRes Upgrade
(Only necessary for Flextight Precision II scanners).

•
•
•
•

Make sure that you have FlexColor 3.0 installed.
Register your scanner.
Order the OptiRes package from your Flextight dealer.
Fill out the fax reply form supplied with the OptiRes package and
return it to Imacon. Imacon will subsequently supply you with an
update code.

• Start FlexColor 3.0.
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• Select the OptiRes upgrade... function from the Maintenance menu.

• Enter the supplied update code in the Update code field and click the
Update button.

• Your scanner has now been updated enabling all the benefits of the
OptiRes functionality.
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The Setup Window
Introduction
The Setup window shows many settings that affect the image and the
way in which the other tools in the FlexColor application work. All of
the settings displayed in the window can be saved and loaded from your
hard disk.
To open the Setup window, select Setup from the File menu.

Many of the settings, such as sharpness, gradation, and color correction,
are available individually through tool buttons in the main FlexColor
window. All settings you make using the individual tools are also
applied to the Setup window, and vice versa.
The Setup window is divided into several tab sheets to help you find the
setting you want to make.
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The FlexColor Setup Philosophy
With a traditional drum scanner, the professional operator requires
extensive education and experience to make all of the settings required
to obtain good results. The operator examines each original and,
applying his or her experience, enters a best guess of what all the setting
should be for that particular type of original. Then the operator checks
the preview and makes fine tuning adjustments.
FlexColor simplifies this process by enabling you to save a library of
setups that you use most frequently. Nearly all FlexColor settings,
including all settings in the Setup, Gradations, Histogram, and Unsharp
Mask windows, are saved in each setup file.
Each time you scan a new original, select the closest setup from the
Setup menu, define the crop, click on the Auto button, and you are 98 to
100% of the way to a perfect scan.
FlexColor is delivered with several generic setups to get you started
quickly. Use the Setup pop-up menu to choose a setup that is
appropriate for your original. The name of each setup indicates its
intended use.
The following naming conventions apply:

• Saturated: The setup applies extra saturation to colors.
• Dark: The setup is designed to scan dark or underexposed originals.
• CMYK or RGB: Indicates the color space of the file created by the
setup.

• Setups designed to scan negatives are each named for a brand of

negative film. Each of these is set up to create an RGB file. To generate
a CMYK file, choose the negative setup that matches your film type,
then open the Setup window and choose a CMYK output profile.

Start by using the generic setups. If you want to develop your own setup
library, begin with the closest of the available generic setups, modify it,
and save it with a new name.

Managing Setups
To create a new setup, click on the New button. A window will appear in
which you can name the new setup. All of the settings currently applied
in the Setup, Gradations, Histogram, and Unsharp Mask windows will
be saved in the new file.
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To rename the currently loaded setup, click on the Rename button. A
window will appear in which you can rename the setup.

After you have made changes to the current setup, save them by clicking
on the Save button in the Setup window.
To delete the current setup, thereby removing it from the Setup pop-up
menus, click on Delete.
NOTE! The generic setups that ship with FlexColor are locked so that
you can not accidentally modify, rename or delete them. If you want to
modify a generic setup, then select the setup from the Setup pop-up
menu, make modifications, then click on New to save your new setup
with a new name.

Advanced Setup Management
The Setup pop-up menu in the main FlexColor window is organized
into sections. Positive film setups are in the top section, followed by
negative film setups. User-defined setups appear at the bottom of the list.
All of the setups are saved as individual files in a folder called Settings,
which is in the same folder as the FlexColor application. Each section
shown in the Setup pop-up menu corresponds to a folder inside the
Settings folder. If you would like to customize the organization of the
menu, then you can add new folders and/or move setup files as
required.
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The General Tab
The General tab of the Setup window affects the general behavior of the
interface and identifies the setup file currently loaded.

Mode
Provides a pop-up menu for choosing the color space used by the
application. The following options are available:

• RGB: stores final images as standard 8-bit RGB TIFF files.
• RGB 16-bit: stores final images as 16-bit TIFF files. This preserves the
full color resolution captured by the Flextight scanner, but creates
larger files that many applications cannot read. Tonal range and
gradation settings will have no effect if you use this mode.

• Grayscale: creates grayscale images, such as black and white

photographs. Grayscale files are smaller than color files, so use this
mode if your originals or final publications are in black and white. To
obtain a grayscale result, FlexColor combines information from all
three RGB color channels. ICC profiles have no effect when you scan
using this mode.

• Grayscale 16-bit: stores final images as 16-bit grayscale TIFF files. This
preserves the full tonal range captured by the scanner, but creates files
that many applications cannot read. Tonal range, gradation and ICC
profile settings will have no effect if you use this mode. To obtain a
grayscale result, FlexColor combines information from all three RGB
color channels.
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• Lineart: creates 1-bit images in which each pixel is either 100% black

or 100% white. These files are even smaller than grayscale images. Use
this mode if your originals are, for example, pen and ink drawings. To
adjust the threshold at which the input will jump to either black or
white, use the Gradations window. See "Setting the Threshold for
Lineart Scans" on page 58 for more information. ICC profiles have no
effect when you scan using this mode.

• CMYK: creates print-ready color images. You must set up an ICC

profile to create CMYK images directly from FlexColor. See
"ColorSync or ICM Tab" on page 37 for more information about ICC
profiles.

Frame
Provides a pop-up menu for choosing the format of the original (35mm,
4"x5", A4, etc.).

Resolution DPI
Defines the resolution of the output image. Set this value according to
the requirements for your printed output. Most high-quality color work
uses 300 dpi. Newspapers typically use less (150 to 200 dpi). On-screen
display, such as for the web, requires only 72 dpi.

Descreen
If you are scanning an offset-printed original, then this setting will
compensate for rosettes in the original. It attempts to prevent moiré
patterns from appearing in your print, at the expense of defocusing the
image. The higher the setting, the more extreme the effect will be.

Mirror
If your original is a mirror image, or if you want to create a mirrored
image from the original, then place a check in this box. To keep the
image as scanned, make sure this box is not checked.
NOTE! It is also possible to mirror your image directly from the main
FlexColor Window using the Mirror button (see page 19 for details).
Mirroring the image using the Mirror button will automatically place a
check in the Mirror check box.
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Units
This set of radio buttons enables you to select the units used to display
Height and Width values in the main FlexColor window.

Film Type
Use this pop-up menu to identify the type of original you are scanning.
The following options are available:

• Positive: for positive color or black and white images.
• B/W Negative: for negative black and white images.
• Color Negative: for negative color images.

Preview crop area only
When this box is checked, then your settings for tonal range and
gradation will only be shown inside your selected crop area on the
preview image - the rest of the image will appear just as it was scanned.
When this box is not checked, then your settings will be shown
everywhere in the preview image.

Enhanced shadow detail
Activates an algorithm that delivers more details in the shadow areas.
This function is active by default and should only be deselected for
images with a very narrow dynamic range or for images with an
unusually high amount of color information in dark areas.
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The Contrast Tab
The settings on the Contrast tab sheet are exactly the same as in the
Gradations window (available from the Windows menu). Changes
made here in the Setup window will also change the settings in that
window, and vice versa. See"The Gradations Window" on page 51 for
more information about these settings.

The USM (Unsharp Masking) Tab
The settings in the USM tab reflect those made in the Unsharp Mask
window (available from the Windows menu).

For more information about unsharp masking, see "Unsharp Masking"
on page 65.
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The USM (Unsharp Masking) Tab

Amount
Controls the strength of the sharpening effect. The higher the value, the
stronger the sharp lines will become. Depending on your image, a value
between 80 and 200 is recommended.

Dark limit
Sets the brightness level below which the filter has no effect. This will
keep the filter from enhancing noise or unwanted textures in your image.
The higher this number, the less extensive the sharpening effect will
appear. Depending on your image, a setting between 0 and 20 is
recommended.

Grain limit
Prevents the filter from sharpening low-contrast features in the image,
such as film grain, noise, or textures. It works by comparing brightness
of each pixel to the brightnesses of its surrounding pixels. If brightnesses
differ by less than the Grain limit, then no sharpening is applied to the
target pixel. If your image looks grainy after sharpening, try to increase
the Grain limit setting.

Radius
Sets the radius in which the unsharp masking algorithm looks for sharp
edges. The larger the radius, the more extensive the sharpening effect
will be. The setting you choose will depend on the contents on your
image and the resolution you are using. Generally, use a large radius (4
or 5) with high-resolution images. Use a smaller radius (1 to 3) for lower
resolutions images.

Color %
These three fields (Red, Green, and Blue) control the amount of
sharpening effect applied in each color channel. Normally, you should
leave them set to 100 each, which applies sharpening equally to all
channels. In some cases, you may be able to reduce the effect of noise by
applying less sharpening to one channel (typically the blue channel). You
can also use these settings to create special effects.

Apply
Mark this checkbox to apply the unsharp mask filter to all scans. Remove
the check to disable the filter.
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The CC (Color Correction) Tab
The CC tab contains a color correction chart, which enables you to alter
the way input colors are mapped onto the output colors. It can be used to
remove or add color cast, or to create stronger colors in your images.

The matrix contains the same settings as the Color Correction window
(available from the Windows menu), and displays all of the settings you
have made using that window. In many cases, it will be easier for you to
make adjustments using the Color Correction window instead. See
"Selective Color Correction" on page 63 for more information.
To activate the color correction, mark the Apply check box. To disable
the color correction settings, remove the mark from this box. Click on
the box to toggle the mark.
To modify the amount of any one color component in the image, click on
the button next to the target color along the top of the matrix. Then use
the up and down buttons for each component color along the left side of
the matrix to add or remove that component from the target color.
Alternatively, you can click on any of the fields in the matrix and edit the
value with your keyboard.
To modify the saturation in the entire image, use the Saturation up and
down buttons or input field.
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The CC (Color Correction) Tab

To enhance color saturation, try the following matrix:

R
G
B
C
M
Y

R
10
0
0
0
0
0

G
0
10
0
0
0
0

B
0
0
10
0
0
0

C
0
0
0
10
0
0

M
0
0
0
0
10
0

Y
-0
0
0
0
0
10

More red in the red
More green in the green
More blue in the blue
More cyan in the cyan
More magenta in the magenta
More yellow in the yellow

NOTE! You can also increase or decrease saturation by using the
Saturation adjustment at the bottom of the matrix. The matrix above is
equivalent to setting the Saturation to +10 when all other values are
zero.
To reduce the amount of magenta:

R
G
B
C
M
Y

R
0
4
0
0
-4
0

G
0
4
0
0
-4
0

B
0
4
0
0
-4
0

C
0
4
0
0
-4
0

M
0
4
0
0
-4
0

Y
0
4
0
0
-4
0

Neutral red
More green in all colors
Neutral Blue
Neutral Cyan
Less Magenta in all colors
Neutral yellow

A full explanation on all of the applications of this tool would be
complex and beyond the scope of this manual. If you would like to know
more about color mapping, please speak with your printer or consult the
electronic prepress section of your local library or book store.
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The Auto Tab
The Auto tab sheet has percentage settings for both Shadow and
Highlight. When you use the Auto button, the FlexColor application
computes what it thinks the highlight and/or shadow values should be
based on the histogram of your image. It then modifies the values by the
percentages that you set here to find the final setting. The percentage is
applied to the difference between the highlight and shadow settings.

For example, if the Auto % for Highlight is set to 2 and you use the auto
function on an image in which the highlight might normally be 200, then
FlexColor will assign a highlight value of 196 (provided the shadow
value were zero). If you find that you frequently need to adjust the
highlight or shadow values to be tighter than the auto function normally
chooses, then use a positive setting here. Positive settings will result in a
relative increase in the contrast.
You are able to set negative values for the Auto % settings. This will
make the automatic controls use less extreme settings for highlight and
shadow then normal. For example, if the Auto % for Highlight were set
to -2, and you use the auto function on an image in which the highlight
might normally be 200, then FlexColor will assign a highlight value of
204 (provided the shadow value were zero). This setting will enable you
to preserve more details at the extremes of the tonal range than you
otherwise would if the highlight point were set lower.
This tab sheet also contains two check boxes named Remove cast. When
one or both of these are checked, then FlexColor will automatically
neutralize the colors in the highlight or shadow respectively whenever
you use the color pickers or Auto button.
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Use the Remove cast option when your images contain neutral highlight and shadow points. If the brightest points in your image are not
white (such as in a sunset), then do not use the Remove Cast option for
highlight. Similarly, if your shadow points should not be black, do not
use the automatic cast removal for shadows. Note that the Histogram
window contains a button called Keep Cast, which removes the effect of
the Remove Cast options.
For more information about working with highlight and shadow points,
see "The Histogram Window" on page 57.

The Dot Tab
These settings affect the output of the image brightnesses. Normally, the
output will be a maximum (255) at the brightest (highlight) point and
minimum (0) at the darkest (shadow) point for each color. However, this
can sometimes cause trouble for the printing presses, especially when too
much ink is applied for the paper to dry quickly enough.

Printers often request that images be prepared to lie within certain limits. The settings on this tab sheet limit output at the extremes at each
color. Speak to your printer for advice about how to set these values.
The values in the three (RGB) columns control the maximum (for
highlight) or minimum (for shadow). For RGB color, 8-bit values (0 to
255) are shown for each color.
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The Endpoints pop-up menu determines how the values for the color
columns will be assigned when the input values exceed the defined
limits. They work as follows:

Cut-off:
All values beyond the limit will remain at the limit.
Round-off: All values beyond the limit will be spread out evenly
between the limit and the maximum (0 or 255).
Force max:All values beyond the limit will be forced to the
maximum (0 or 255).

ColorSync or ICM Tab
ICC color profiles define the color response of each device in your
system. FlexColor uses these profiles to make calibrated, accurate, and
high-quality color separations from your scans.
Under Mac OS, ICC profiles are controlled by Apples ColorSync
technology and the setup tab for selecting ICC profiles in FlexColor is
called ColorSyncTM.
Under Windows 98 and 2000, ICC technology is referred to as ICM
(which stands for "Image Color Management") and the tab for selecting
ICC profiles in FlexColor is called ICM.
Flextight scanners and most monitors and output devices include ICC
profiles, which will help make sure the colors in your original are
maintained and that colors you see on your screen will be accurately
reproduced on paper.
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For more information about using ICC profiles, see the online help for
your operating system.
For information about Apples ColorSync technology, check Apple's web
site at:
http://www.colorsync.apple.com and/or http://www.apple.com.
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Input
This pop-up menu shows a list of input ICC profiles installed on your
system. Select the Flextight Input profile from the list.

RGB
This pop-up menu lists all of the RGB profiles currently installed on your
system. Choose a profile that represents the color space in which you
work on-screen. (If you are using Adobe Photoshop, you can save the
space used by Photoshop as an ICC profile. To do this, start Photoshop
and choose File -> Color Settings -> RGB Setup. The RGB Setup window
appears (see the Getting Started... manual for more information about
using this window).

Click on the Save button and save your selected RGB working space as
an ICC profile. Give the profile a new name and save it in the ICC profile
folder used by your operating system. For most recent versions of the
Mac OS, use the ColorSync Profiles folder inside the System Folder.
For Windows 98, use C:\WIN98\SYSTEM\COLOR\. The RGB drop
down list in the RGB Setup window now shows the name of the file that
you just saved.)

CMYK
This pop-up menu lists all of the output profiles currently installed on
your system. Choose the profile specific for your output device, or select
the closest of the generic profiles supplied with FlexColor. See "Generic
ICC Output Profiles" on page 45 for more information about the generic
profiles.
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Convert
Mark this checkbox to apply your ICC selections to your scans. Remove
the check to disable ICC profiles.

Softproof
Mark this checkbox to see an on-screen representation of the colors
expected from your output device. It combines the output profile with
the monitor profile selected for your system to create a simulation of the
output colors. See the Getting Started... manual for instructions on how to
set up a monitor profile for you system and for advice about using the
Softproof feature.

Embed Profile
Mark this checkbox to embed a profile with your scanned image. If you
are scanning to RGB, then the RGB profile will be embedded. If you are
scanning to CMYK, then the CMYK profile will be embedded. If no
output profiles have been chosen, then the input profile will be
embedded.

Edit
The Edit button appears only if you are using the Mac OS version of
FlexColor. Click on this button to edit the output profile. Use this feature
only if you are an advanced user, or on the advice of your printer. For
more information about editing ColorSync profiles, see "Editing
ColorSync Color Profiles" on page 46.
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The Preferences Window
The Preferences window contains several miscellaneous settings that
control the general functions of the scanner and the software. The
Preference window settings are universal for the FlexColor application
they are not saved with the other settings in the setup files. To open the
window, select Preferences from the File menu.

Power-Saving Features
To save power, you are able to make settings that will cause the scanner
to shut down after a specified period of inactivity. There are two levels of
power saving available:

• Power down after: the scanner is turned off, just as if you had pressed
the on/off button on the scanners front panel.

• Light off after: the scanner remains turned on, but the light is shut off.
Use the sliders to make settings for how long the period of inactivity
should be before activating the relevant power-saving function.
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Custom Frames
Flextight ships with a selection of original holders that support several
standard formats of originals. It is also possible to use custom, nonstandard formats with Flextight. A larger number of custom frame
formats can be defined at any one time.
To define a Custom frame do the following:

• Press the New button.
• In the pop-up, name your frame and press Create. This is the name

that will appear in the Frame pop-up menu in the main FlexColor
window and in the Frame pop-up menu on the General tab in the
Setup window. Type a name that will help you remember the format.

• From the Type pop-up menu select the standard frame type that most
closely matches your custom frame.

• Type in the Width and Vertical offset values of your frame.
• NOTE! If you have upgraded your scanner with the OptiRes

functionality, you are able to specify both Width, Height and Vertical
offset for transmission frames, but reflective frames are still limited to
the few fixed widths because of the white calibration used in
reflective mode.

• Press OK.

Use External White Calibration
Some older Flextight Precision scanners make use of this option when
checking the white calibration. However, we now recommend that all
Flextight users use external calibration, so this box should always be
checked. On other Flextight models, this box does nothing.
If you are using a Flextight Precision scanner, then see the calibration
information in your original scanner hardware manual for details.

Opening Saved Images
After taking a final scan, FlexColor is able to launch the application of
your choice and open the saved image in that application. If you would
like to use this feature, then place a check in the Open in checkbox. Then
click on the Select button. A standard file finder window appears. Use it
to locate and select the application you would like to use for viewing
your final scans.
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Auto after New Crop
FlexColor includes an auto tonal range function, which analyzes the
cropped image and sets highlight and shadow values accordingly. You
can use it at any time by clicking on the Auto button in the main ColorFlex window.
The Auto after new crop checkbox provides an optional shortcut for
using the auto function. When this checkbox is marked, each time you
make a new crop, FlexColor will immediately analyze the image
contained in the crop area and set highlight and shadow values, just as if
you had clicked on the Auto button.
You can also control this function by holding down the option key as
you define a new crop:

• If the Auto after new crop checkbox is enabled, then hold down the
option key to make a new crop without invoking the auto function.

• If the Auto after new crop checkbox is disabled, then hold down the
option key to apply the auto function to your new crop.

NOTE! This function will not update the highlight and shadow settings
when you move or resize an existing crop area; it only responds when
you create a new crop area. If you would like to use the auto function
again after moving or resizing a crop area, click on the Auto button in
the main FlexColor window.
For more information about tonal range and the Auto function, see "The
Histogram Window" on page 57 and "The Auto Tab" on page 35. For
more information about cropping, see "The Main FlexColor Window" on
page 15.
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FlexColor ICC Profiles
Generic ICC Output Profiles
FlexColor includes six generic ICC output profiles for generating various
types of color separations. The name of each profile provides a
description of the results it creates. See Table 1 for details.
Black
Generation

Max
Black

250%
Flextight 250%
GCR 40% K.90%

GCR 40%

90%

n/a

Newspapers,
low ink

280%
Flextight 280%
GCR 30% K.90%

GCR 30%

90%

n/a

Newspapers,
standard

330%
Flextight 330%
GCR 20% K.95%

GCR 20%

95%

n/a

Glossy paper
(magazines)

Skeleton
Black

75%

30%

General use,
glossy paper

GCR 20%

95%

n/a

High-end, high
ink

Skeleton
Black

91%

30%

Extreme highend (e.g. art repro)

Profile

Flextight 330%
Skel. K. 75/30%

Max
Ink

330%

350%
Flextight 350%
GCR 20% K.95%
Flextight 350%
Skel. K. 91/30%

Table 1:

350%

Black
Starts

Use

Generic ICC output profiles included with FlexColor.

GCR stands for gray color replacement. It is a scheme for adding black to
dark colors, thereby reducing the total amount of ink applied. A high
percentage of GCR results in more black ink in the image (and,
consequently, less ink of other colors).
The skeleton black scheme does not add nearly as much black especially in the colors, thus resulting in brighter colors, but also
requiring higher quality paper. These profiles also specify the minimum
ink percentage in each channel that a color must have before any black is
added at all.
If you are not sure which profile to use, ask your printer if there is a limit
on the maximum ink percentage and be sure to choose a profile that
limits the percentage appropriately. In the majority of cases, the Flextight
330% Skel. K. 75/30% profile will provide the best results.
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In some cases, a ICC profile for your (or your service bureaus) specific
output device may be available. If so, then use it instead.
If your results are not satisfactory, then speak with your printer for
advice about how you should modify the profile. See "Editing ColorSync
Color Profiles" on page 46 for instructions.

Editing ColorSync Color Profiles
NOTE! The profile editor is only available with the Mac OS version of
FlexColor.
Flextight includes both a ColorSync input profile designed for the
Flextight scanner and a set of generic output profiles, each of which is
designed to create good results under a different set of conditions.
These generic profiles will deliver adequate to excellent results. If, after
testing an output profile and speaking with your printer, you find that
you would like to fine tune an output profile, then follow the procedure
below.
The settings available for editing the output profiles are both highly
detailed and very powerful. In general, they are intended for users who
are very experienced in making color separations. Most likely, you
should speak with your printer about how to make these settings. The
Flextight scanner includes a Fax to Printer sheet, which you can deliver
or fax to your printer to help you fill-in these numbers if necessary.
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1.

Run the FlexColor application.

2.

Choose Setup from the File menu. Then click on the ColorSyncTM
tab.

3.

Use the Output pop-up menu to select the profile you would like to
edit. Note that the profile you select must be as close as possible to
the profile you want to make - you are not able to create a
completely different profile using the editor. The menu lists all of the
profiles currently installed in the ColorSyncTM Profiles folder in the
Preferences folder of your System Folder.

4.

Click on the Edit button. The Output Profile window appears.

5.

We recommend that you save your edited profile using a new name,
so click on the Save as... button.
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The Create New Profile window appears. Type a name for your
edited profile and click on the Create button.

6.

Return to the Output Profile window. It shows the output values
applied in the final separated file for each color at each of four
brightness (neutral-gray) levels (0%, 5%, 50%, and 100%). By
adjusting these levels, you are able to control how colors will appear
in your output. For example, if your prints look too yellow in the
highlights, then you could turn down the Y value for 0% and/or 5%
values. In many cases, this is all the level of detail you will need.

7.

The Dot Gain Compensation setting compensates for the default
dot-gain setting of the existing profile. The setting is relative, and
can be positive or negative. Generally, this value varies from printer
to printer. Finding the correct setting will require some trial and
error.
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8.

If you need to make even more detailed adjustments, then click on
the triangle next to the Advanced heading.

9.

The Advanced section includes value settings for even more gray
levels. These settings include the same four levels that you were able
to adjust using the standard part of the Output Profile window.

10. When you are done making settings in the window, click on the
Save button to apply the settings to your new profile.
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The Gradations Window
Introduction
The functions described in this section will not always be needed during
normal scanner operation. They enable you to make fine adjustments to
your output scan that will affect brightness and contrast and will
compensate for printing conditions. As with the advanced highlight and
shadow controls, take care when using the Gradations settings. Take
some time to experiment with its settings. Look at the preview to see
how the curve will effect scans. Take some final scans after using the
settings and inspect them closely. Take notes on the kind of settings you
use and make a comparative proof print.
To open the Gradations window, click on the Gradation
button in the Correction area of the main FlexColor window,
or select Gradations from the Windows menu.

The Gradations window includes sliders for Contrast, Brightness,
Gamma and Shadow depth. It also includes a gradation curve, which is
a plot of input brightness (on the horizontal-axis) versus output
brightness (on the vertical-axis). You can hide or show the curve by
clicking on the small triangle beneath the Shadow depth slider.
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All of the settings you make using the curves and sliders in the
Gradations window are saved with the current setup. The contrast,
brightness, gamma and shadow depth settings can also be adjusted
using the Contrast tab of the Setup window.

Using the Sliders
The sliders provide a quick and easy way to adjust the contrast,
brightness, gamma, and/or shadow depth of your images. These
adjustments affect the image, but are not reflected on the gradation
graph that appears at the bottom of the window if you click on the
triangle.
The sliders behave as follows:

• Contrast: This control affects the contrast in the image. Positive values

increase contrast in the overall image by compressing the contrast in
the highlight and shadow areas. Negative values reduce contrast in
the midtones, but improve visibility at the extremes of the tonal range.
This control is easy to use, but is less precise than using the curve.

• Brightness: This control affects the brightness of all points in the

image. Positive values brighten the image, negative values darken it.
This control is easy to use, but is less precise than using the curve.

• Gamma: The gamma setting applies a predefined gradation curve.

However, unlike the standard gradation curve, the gamma setting is
strictly controlled, so it enables you to use a color management
program that is calibrated to the Flextight scanner at a given gamma
setting. The default is 2.0. If you raise the gamma setting, then the
image will become lighter and more details will be visible in the dark
areas. The opposite occurs if you decrease the setting.

• Shadow depth: This setting controls a complex algorithm that affects

the level of detail visible in the shadow areas of your image. The
higher you move this slider, the more detail you will be able to see in
the shadows. However, this will also reduce contrasts in the rest of the
image. A setting of zero effectively disables this feature.

To neutralize all settings in all color channels of the gradation curve and
sliders, click on the Reset button. None of your other FlexColor settings
will be affected.
NOTE! The sliders affect all colors equally. They are not affected by the
setting in the color channel pop-up menu located above the gradation
curve.
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Using the Color Picker
The Color Picker in the lower left corner of the Gradations
window enables you to place a gravity point on the curve at
the brightness of a point that you select in the preview. Click
on the eyedropper icon to activate the gradations color
picker, then click on a point in the preview to place the
gravity point. See the next section for more information
about using the curve.

Using the Curve
The gradation curve is a plot of input brightness (on the horizontal-axis)
versus output brightness (on the vertical-axis). It provides extremely
detailed control over brightness and contrast in your final image, and
even provides individual control over each color channel. You can hide
or show the curve by clicking on the small triangle beneath the Shadow
depth slider.
To adjust the curve, click and drag on the graph. Each time you click on a
new point, you will create a gravity point, which will pull the curve
toward itself. This system makes sure that the curve is always smooth.
The preview image will update to reflect your changes.
Here are some guidelines to help you make adjustments to the gradation
curve:
More overall brightness

More overall contrast

More shadow details

• To add a gravity point to the curve, click anywhere on the graph.
• To remove a gravity point from the curve, click on the point and then
press the backspace button on your keyboard.

• A neutral (default) gradation curve is a straight, diagonal line from the
lower left to the upper right of the graph.
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• To add brightness to the image (without affecting the highlight value),
drag the curve up above neutral. To darken an image, drag it below
neutral.

• To reduce the contrast in the shadow, midtone, or highlight make the
curve more flat on the bottom-left, center, or top-right areas
respectively.

• To increase the contrast in the shadow, midtone, or highlight make the
curve more steep on the bottom-left, center, or top-right areas
respectively.

• To adjust the gradation in a single color channel, use the pop-up menu
located above the gradation curve. Options are: RGB, Red, Green,
Blue, Cyan, Magenta, or Yellow. This gives you a very powerful
method of adjusting color in your images.

• To adjust the gradation without changing the color balance, set the
pop-up menu above the gradation curve to RGB.

• All of the settings made to the gradation curve are saved with the

setup, just as all of the settings shown in the Setup window. See
"Managing Setups" on page 26 for instructions about how to select,
load and save setups.

• To neutralize all settings in all color channels of the gradation curve

and sliders, click on the Reset button. None of your other FlexColor
settings will be affected.

Keyboard Shortcuts
While working with the gravity points on the gradation curve you have
the following possibilities:

• Pressing ctrl-tab to step between gravity points (when more than one
point is defined)

• To move a gravity point, either drag it with your mouse or activate it

and then use the arrow buttons on your keyboard. Hold down the ctrl
key to move the point in larger increments.

• While dragging a gravity point using the mouse, hold down the shift
key to restrict its movement to the horizontal direction.

Software Reference - FlexColor 3.0 for Flextight Scanners

The Gradations Window
Setting the Threshold for Lineart Scans

Setting the Threshold for Lineart Scans
When you are scanning in Lineart mode, FlexColor applies a threshold
to the scan to create an image in which every pixel is either completely
black or completely white. In this case, the gradation curve is simply a
vertical line. You can move this line left or right to adjust the input level
at which the threshold is applied.
Click and drag on the line to adjust the threshold level to the right
(which cause more pixels to go to black) or the left (which will cause
more pixels to go to white).
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The Histogram Window
Introduction
The easiest way to set the highlight and shadow points is to use the Auto
tonal range button in the main FlexColor window. However, in some
cases, the auto function will not provide the desired results. The color
pickers and sliders in the Histogram window provide the tools you need
to fine tune your highlight, shadow, and midtone points.

• The Highlight Point is the brightness above which all input pixels will
be output at white (usually 255, unless you have set values in the Dot
tab sheet of the Setup window - see "The Dot Tab" on page 36 for
details).

• The Shadow Point is the brightness below which all input pixels will

be output at black (usually 0, unless you have set values in the Dot tab
sheet of the Setup window - see "The Dot Tab" on page 36 for details).

• The Midtone Point is the brightness exactly midway between the

highlight and shadow points. You are only able to set midtone points
in the red, green, and blue channels - not for the overall image. These
settings are used to control the color cast.

You must take care when using these settings, as they can have a
powerful effect on your scans. Take some time to experiment with them.
Look at the preview to see how these settings will effect scans. Take
some final scans after using these controls and inspect them closely. Take
notes on the kind of settings you use and make a comparative proof
print.
If you do not have any experience with scanning, then you should speak
with an experienced scanner operator about how these controls will
affect your images. Ask him or her what to look for when you are
evaluating your proof prints. You should also read some books about
scanning, digital imaging, and color reproduction.
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The Histogram Display
To open the Histogram window, click on the Histogram
button in the Correction area of the main FlexColor window,
or select Histogram from the Windows menu.
The Histogram window contains a graph that indicates the tonal range
of your image. The graph displays the number of pixels (on the vertical
axis) of each brightness (on the horizontal axis). Pixels with a value of 0
(black) are shown on the left; pixels with a value of 255 (white) are
shown on the right.
Shadow color picker
Neutralize color picker
Highlight color picker

Maximum output value
and slider

Minimum output value
and slider

Shadow value
Shadow value

Highlight slider
Highlight value

Hide/show color channels

Color Pickers
These enable you to click on pixels in your image to set highlight,
shadow and neutral points. See "The Histogram Color Pickers" on page
60 for more information about using them.
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Sliders
Click and drag the sliders to set the highlight and shadow points and to
set the minimum- and maximum output values. The min. and max.
output values reflect the settings on the Dot tab of the Setup window.
NOTE! You can also use the arrow keys on the keyboard to move a
slider once it has been selected. Hold down the ctrl key to move in larger
increments. Use ctrl-tab to step between sliders.

Keep Cast Button
Click on this button to keep the highlight level, but to remove all settings
that affect the color cast. For example, if you used the Auto function to
remove color cast, highlight and shadow values will be assigned
separately in each channel in an attempt to create a true, neutral
highlight point. If you then clicked on the Keep Cast button, all highlight
sliders will be set to the same value, thus keeping the highlight level, but
preserving the color cast in the original image. To turn the auto cast
removal on or off, use the Auto tab of the Setup window, as described in
"The Auto Tab" on page 35.

Auto Button
Click on this button to have FlexColor assign highlight and shadow
values based on the histogram of your image. If the current setup is
configured to remove color cast, the image will also be automatically
neutralized. The Auto tab of the Setup window contains settings that
affect the way this function works and turn the color correction on and
off. See "The Auto Tab" on page 35 for more information.

Reset Button
Click on this button to remove all highlight, neutralize, color cast and
shadow settings.

Show Final Values Checkbox
Mark this checkbox to display the histogram as it appears after the
highlight and shadow values are applied. Remove the check to work
while viewing the histogram of the scanned image before these settings
are applied.
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Hide/Show Color Channels
Click on this triangle to display separate histograms for each color
channel. You are able to adjust highlight and shadow values separately
for each. Note that each of the color channel histograms has a gray slider
for setting the midtone point. The relative position of the slider between
each color channel affects the color balance of the overall image. These
sliders indicate the setting made using the neutralize color picker.

The Histogram Color Pickers
The histogram color pickers enable you to point at any pixel in your
preview image and assign the highlight, midtone, or shadow point based
on the value of that pixel.
Both the highlight and shadow color pickers will affect the brightness
and contrast in your image by choosing the tonal range.
The neutralize color picker will only affect the color balance without
adjusting overall brightness.
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To use the color pickers:
1.

Click on the appropriate eyedropper button for the type of tonal
range setting you would like to make. Your mouse pointer turns into
the selected eyedropper.

2.

Move the mouse pointer over the preview image; note pixel value
readings that appear in the Color area of the main FlexColor
window. Note that the numbers displayed in the Color area are the
current values (after histogram or gradation settings).

3.

The Magnifier window, which shows a magnified view of the
preview image under the color picker, can help you see individual
pixels. To open the Magnifier window, select Magnifier from the
Windows menu (or click on the Magnifier button in the Zoom area
of the main FlexColor window). Note that the selected pixel is outlined at the center of the window.

4.

Place the tip of the eyedropper over an appropriate pixel in the
preview image.
• When selecting a highlight point, select an object in the image that
you would like to have print white. Check the pixel values at
several potential white points to help you pick the best one
(usually the brightest one that is not already at the maximum of
255 in any of the colors). All pixels brighter than the one you
selected will burn out.
• When selecting a shadow point, select an object in the image that
you would like to have print black. Check the pixel values at
several potential black points to help you pick the best one
(usually the darkest one that is not already at the minimum of 0 in
any of the colors). All pixels darker than the one you selected will
be black.
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• When selecting a neutralize point, select an object in the image
that should be a neutral (gray) color. This will not affect the image
brightness, only the color cast. For best results, select a point close
to the middle of the exposure range, for example with RGB pixel
values around 150.
5.

Click on the target point. The highlight, shadow or gray value will
be reassigned to the values shown for that pixel in the info area.
Your screen will be instantly updated.

6.

Inspect the preview using the Magnifier window and Color area.
Look for areas that are burned-out (showing values of 255) and also
check the shadow areas to be sure you have not hidden any details
in these areas.

Neutralizing Colors
Sometimes, variations in film emulsions and other factors will corrupt
the colors in your originals. If your image contains an area that should
look flat gray or white, but instead shows a color cast, then you can
correct it using the neutralize color picker as described in the previous
section. You can adjust the color cast manually by using the sliders in the
expanded Histogram window as described earlier.
Note also that you can remove color cast in your highlight and shadow
areas by using the Auto highlight and shadow button or the highlight
and shadow color pickers. This is optional, according to the settings in
the Auto tab of the Setup window. See "The Auto Tab" on page 35 for
more information.
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Selective Color Correction
Introduction
Sometimes you need more control over the image colors than simply
removing a color cast. FlexColor features a powerful selective color
correction feature, which enables you to adjust the appearance of specific
colors throughout your image.

Opening the Color Correction Window
To open the Color Correction window, click on the Color
Correction button in the Correction area of the main
FlexColor window, or select Color Correction from the
Windows menu.

Using the Color Correction Window
To use the Selective Color Correction:
1.

Open the Color Correction window by selecting Color Correction
from the Windows menu, or clicking on the Color Correction button
in the main FlexColor window.

Color before color correction. Click here
to activate the color correction picker.
Color after color correction.

2.

Click on the upper square area to the right in the Color Correction
window to activate the color correction color picker.

3.

Click on the color in the preview image that you would like to
change. The color will immediately appear in the top (before) color
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box. Offsets to its pixel values are listed in the R, G, B, C, M, and Y
fields (by default, these values are all set to zero).
4.

The pop-up menu near the top of the window displays the nearest
primary color to the one you picked in the preview. Adjusting this
color will have the most dramatic effect on the color you chose.
However, if you wish to edit a different primary color, then select a
different color from the pop-up menu.

5.

Add or subtract any of the other colors using the arrow buttons and
numerical entry fields provided for each color channel. Positive
values will add the respective color, negative values will remove it.
All pixels containing the color selected in pop-up menu will be
adjusted proportionately.

6.

If you would like to change the saturation throughout the image,
then use the Saturation slider. The hues will remain the same, but all
of the colors will become either more or less strong, depending on
whether you choose a positive or negative setting, respectively.

7.

The lower square updates to show the effects your changes will have
on the color you selected in the preview. Continue to adjust the
settings until you are satisfied with the color shown in this box.

Note also the Apply checkbox. When this box is checked, the color
correction will be applied to your preview and final scan. Remove the
check to disable color correction without erasing your settings. Click on
the box to toggle the check.
The Reset button returns all color correction setting to neutral. It does
not affect any of your other FlexColor settings.
You can also view and edit settings made in the Color Correction
window by looking at the CC tab in the Setup window. The color
correction settings are saved and loaded together with all of the other
settings in the Setup window, so you can keep a library of your favorite
settings by saving a new Setup file for each one. See "Managing Setups"
on page 26 for more information.
NOTE! If you are using the Gradations window to lighten the image,
then you may notice that the saturation decreases. To compensate, you
may then increase the saturation in the Color Correction window, which
will make the image look a bit darker again. Avoid entering a cycle in
which you repeat each of these settings until both windows are set to
extremes. Extreme settings will typically degrade your image.
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Unsharp Masking
Introduction
As your images are scanned, the unsharp mask filter applies an
algorithm that increases contrast along sharply defined edges.
Unsharp masking has the potential to both improve and degrade your
image - it makes the features more sharp, but can also bring out noise or
graininess. Most typically, noise will appear first in the dark areas of the
image. This is why FlexColor enables you to take final-resolution
previews of the sharpness effect at two different parts of your image.
Use one preview to see if there is enough sharpness to bring out the
important features in the bright or midtone areas. Use the other preview
to check if the setting will bring out too much noise in the dark areas.

Using the Unsharp Mask Window
To open the Unsharp Mask window, click on the Sharpness
button in the Correction area of the main FlexColor window,
or select Unsharp Mask from the Windows menu.

To change the filter's settings, click in the appropriate field and edit the
value with your keyboard or use the up and down arrow buttons. The
controls have the following effects:

• Amount: Controls the strength of the sharpening effect. The higher the
value, the stronger the sharp lines will become.

• Dark limit: Sets the brightness level below which the filter has no

effect. This will keep the filter from enhancing noise or unwanted
textures in your image. The higher this number, the less extensive the
sharpening effect will appear.
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• Grain limit: Prevents the filter from sharpening low-contrast features

in the image, such as film grain, noise, or textures. It works by
comparing brightness of each pixel to the brightnesses of its
surrounding pixels. If brightnesses differ by less than the Grain limit,
then no sharpening is applied to the target pixel. If your image looks
grainy after sharpening, try to increase the Grain limit setting.

• Radius: Sets the radius in which the unsharp masking algorithm looks
for sharp edges. The larger the radius, the more extensive the
sharpening effect will be. The setting you choose will depend on the
contents on your image and the resolution you are using. Generally,
use a large radius with high-resolution images. Use a smaller radius
for lower resolutions images.

To preview your settings, click on one of the square areas on the right
side of the Unsharp Mask window, then click on a target area in the
preview image of the main FlexColor window. The scanner will take a
new high-resolution scan of a small area of your original and show a
preview of your settings in the Unsharp Mask window. Both previews
behave in exactly the same way. There are two of them so that you can
compare the sharpening effect in two different areas of your image. Use
one to check for enough sharpness in the bright or midtone areas. Use
the other to check for noise resulting from too much sharpness in the
shadow areas.
The Apply checkbox turns the unsharp masking filter on or off. When
the box is checked, the filter will be applied to your final scan and to the
preview image. To disable the filter, remove the check. Click on the box
to toggle the check.
The Reset button returns the filter to its default settings (Amount=100,
Dark limit=10, Grain limit=0, and Radius=1). None of your other
FlexColor setting will be affected.
It is also possible to apply different amounts of sharpening to each color
channel. This is controlled on the USM tab of the Setup window. See
"The USM (Unsharp Masking) Tab" on page 31 for instructions.
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The Magnifier Window
Introduction
The Magnifier window shows a magnified view of the preview image.
The image shown is of the area surrounding the mouse pointer. This
window enables you to see and select individual pixels from the preview. The pixel directly under the cursor is outlined at the center of the
window.

This window is especially useful when you want to read color values for
a specific pixel in your image.

Opening the Magnifier Window
To open the Magnifier window, click on the Magnifier
button in the Zoom area of the main FlexColor window or
select Magnifier from the Windows menu.
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Batch Scanning
Introduction

FlexColor is able to create several different scans of one or more originals
contained in a single original holder. The process is called batch
scanning. Each scan in the batch can have completely different settings
for all ColorFlex windows, including resolution, crop, color space,
sharpening, tonal range, color correction, gradation, and all setup tabs.
To open the Batch Scan window, click on the Batch Scan
button near the top of the main FlexColor window, or select
Batch Scan from the Windows menu.

Setting up a Batch Scan
1.

Define a crop area and make scan settings in the Size area of the
main FlexColor window and in all Setup and Correction windows.

2.

Click on the Batch Scan button at the top of the main FlexColor
window or select Batch Scan from the Windows menu. The Batch
Scan window appears.
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3.

Click on the Add button. A standard file save window will appear.
Use the window to choose a folder and file name with which to save
the scan. The scan will not be taken yet, but its name will be added
to the list in the Batch Scan window.

4.

Make all settings for the second scan you want to take. All settings in
all FlexColor windows are relevant.

5.

Repeat steps 3 and 4 until you have defined all of the scans you want
to make.

6.

If you want to change any of your previously defined scans, click on
the scan name in the Batch Scan window and make changes in the
other FlexColor windows. Then return to the Batch Scan window
and click on the Update button to save your changes. To remove a
scan from the batch set, click on the scan name and then click on
Remove. Note that you can work faster when editing the batch set
by removing the check form the Preview box. When this box is not
checked, the preview image in the main FlexColor window will not
update each time you click on a new scan in the Batch Scan window.
When the Preview box is checked, the preview updates each time,
which takes about a second.

7.

When you are finished defining the scans, click on the Scan button.
FlexColor scans and saves all of the scans you have defined.
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Getting Information about Each Scan
You can see an information window about any scan listed in the Batch
Scan window. To see the Batch Scan Info window, double click on a
scan name from the list in the Batch Scan window.

The window shows the following information:

• Destination: Shows the name assigned to the selected scan.
• Specify button: Click here to change the Destination name and folder.
• Status: Shows the status of the scan. If you are having problems with
the batch scan, look here for help.

• Frame: Shows the original holder being used.
• Mode: Shows the color mode (e.g., CMYK or RGB) that the scan will
be saved in.

• DPI: Shows the output resolution of the scan.
• Est. time: Shows and estimate of how long the selected scan will take.
• Width, Height, and Zoom: These fields display the output size of the
final scan and the zoom level compared to the original.

• Size: Shows the file size of the final scan.
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Working with Batch Presets
If you want to save a batch preset, then click on the New button in the
Batch Scan window. The Create New Batch Preset window appears.
Type a name and then click on Create.

The preset name then appears in the pop-up menu in the Preset area. If
you have several batch presets saved, then you can use the pop-up menu
to switch between them.
To rename a batch preset, select the preset in the pop-up menu, then
click on the Rename button. The Rename Batch Preset window appears.
Type a new name and then click on Rename.

To delete a batch preset, select the preset in the pop-up menu, then click
on the Delete button.
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The Color Info Window
Introduction
The Color Info window enables you to read pixel values at any point in
your image. You can also set up to five fixed Sample points and read the
values at all of them simultaneously to monitor the effects of your other
settings.
To open the Color Info window, click on the Color Info
button in the main FlexColor window or select Color Info
from the Windows menu.

Reading Values in the Color Info Window

To use the Color Info window, place the mouse cursor over the preview
image. The number fields in the window indicate the pixel brightness at
the selected position in the image. Note the following:

• When showing RGB, the values indicate pixel brightness values (0 255) with white = 255, 255, 255.

• When showing CMYK, the output values indicate ink percentage

values (0 - 100) with white = 0, 0, 0, 0. However, input values are still
shown in RGB, as described above.

The Sample pop-up menu indicates the size of the area sampled by the
color picker (mouse cursor). The numbers shown in the Color Info
window indicate averages of the values found in the sample area. You
can choose a setting of 5x5, 3x3 or 1x1 pixels.
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Setting Fixed Sample Points
You are able to set up to five fixed Sample points so that you can
monitor the effects that your settings are having in key areas around
your image. Each sample point is indicated with a diamond and a
number in the preview image. The current values for each sample point
are shown next to the appropriate number in the Color Info window.

To set a sample point, click on the Sample Point button,
which will turn grey when it is activated. Then click on a
point in your image to place the point. A numbered diamond
will then appear on the preview image at the point you
select.
You can work with the sample points as follows:

• To move an existing sample point, activate the sample point picker by
clicking on the Sample Point button to make it grey, then click and
drag on the target point.

• To delete an existing sample point, activate the sample point picker,

click once on the target point and then press the backspace button on
your keyboard.

• To keep the existing sample points, but hide them in the preview,
mark the Hide points check box. To view and/or edit the points
again, remove the mark from this check box.

• To remove all sample points from your preview click Remove all.
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CCD Calibration
Introduction
To make sure all of the pixels in the CCD react equally to low levels of
light, your scanners CCD should be calibrated. If it is not, you may see
some faint single-pixel striping in very dark areas of positives or in light
areas of images that were scanned from negatives. The problem, which is
present in all CCD scanners, is most noticeable when you scan 35 mm
negatives.
The CCD calibration information is stored in a flash PROM inside the
scanner, not on your hard disk. This means that the CCD calibration
(unlike the white calibration) is preserved when you move the scanner to
a new computer.
IMPORTANT! Do not perform CCD calibration unless you are
upgrading your software for use with a scanner that was delivered with
ColorFlex software older than version 1.9. If your scanner came with
version 1.9 or higher, then CCD calibration has been done at the factory;
we highly recommend that you do not repeat it again yourself
(recalibration is neither necessary or advisable).

Making a CCD Calibration
See the hardware documentation for your scanner for more information
about calibration. However, as mentioned above, if you are upgrading
from an older version of the software, then your hardware manual will
not mention CCD calibration. Use the procedure below to calibrate your
CCD sensor using FlexColor.
1.

Find or make a color negative original showing a clear blue sky, or
something similar. The original must not have too many sharp
contours in it.

2.

Mount the original in the 36 x 24 (landscape) original holder and set
the original format in the Frame pop-up menu as usual.
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3.

Choose CCD calibration from the Maintenance menu. The CCD
calibration window appears.

4.

Read the information provided in the CCD calibration window,
then click on Calibrate. The scanner will scan the image. When it is
done, mark the Use calibration checkbox, then click on Done.
NOTE! If your scanner was calibrated at the factory, then a warning
will appear if you try to make a new CCD calibration. It is possible
to dismiss the warning and continue, but we do not recommend that
you recalibrate.

If it seems like the new CCD calibration only made your scans come out
worse, it is probably because your calibration image contained too many
contours.
You have two options for removing the effects of a faulty new
calibration:

• If your scanner was calibrated at the factory, you can return to the

original CCD calibration by opening the CCD calibration window
again and clicking on the Use factory button.

• If your scanner was not delivered with a factory CCD calibration, you
can remove the new calibration by opening the CCD calibration
window again and removing the mark form the Use calibration
checkbox.

If you were having striping problems and the CCD calibration simply
didn't help, then the source of the problem may lie elsewhere; see the
Getting Started... manual for troubleshooting advice.
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